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This document describes how to use Microsoft Word to create all the technical 

parts of a brief – including the cover page, table of contents, table of 

authorities, and more. 

 

 
TIP: The best way to begin is to use the
University of Virginia School of Law
Extramural Moot Court Board Model Brief
Template.  This document has all of the
“hidden” formatting that you will need. 
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I. INTRODUCTION 

 Think of a brief as being one document with three separate Sections.   

 Section 1.  THE COVER PAGE   

 Section 2. THE TABLE OF CONTENTS AND TABLE OF AUTHORITIES  

 Section 3. THE TEXT 

 

 We will learn to insert appropriate section breaks to manipulate the page 

numbering, to view and create a Table of Contents from an outline perspective and 

to mark cases and create a Table of Authorities.   

 

 



2 

II. THE RULES  
 

 Familiarize yourself with the Rules of Court before writing your brief.  All 
rules are searchable but some helpful guidelines are included for easy reference.  
 
 
THE BRIEF – VIRGINIA SUPREME COURT RULES FOR BRIEFS:  
 

http://www.courts.state.va.us/legallinks/va.html 
 
 
THE BRIEF – UNITED STATES COURTS OF APPEALS FOR THE FOURTH CIRCUIT  
 

http://www.ca4.uscourts.gov/pdf/rules.pdf 

 
THE BRIEF – UNITED STATES SUPREME COURT 
 

http://www.supremecourtus.gov/ctrules/ctrules.html 
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III. FIRST SECTION: THE COVER PAGE  

 Creating a cover page for a Brief can be a difficult task, if you let it. 

However, understanding section breaks and headers and footers will make your 

task easier. My goal is to help you understand section breaks.  

1. Begin with a new document 

2. Type the appropriate text.  (Refer to Court Rules to determine what is 
necessary on the cover of the brief.)   

 
3. Select “Insert”  

 
Select “Break”  

  Under Section Break Types, select Next Page  

      

 

(Notice that the very bottom of your screen reads Page ___ Section 2.)  
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Changing the Numbers in the Footer  

 The Brief Cover not does have a page number on it. Therefore, we will 
remove any page numbers from the first page and set the numbering style on the 
first page of the second section to roman numbers.   

 

Select View 

 Select Header and Footer  

A toolbar will open. Select the Icon that looks like an open 
book (Page Setup)  

   Select New Page  

    Select Different first page  

     Click “OK” 
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While still in the Headers Toolbar, Select “Format Page Number”  (the third icon from the 

left and looks like a hand holding a piece of paper with a large blue number on it) … 

 

 Select Page Number Format  

 Change Number Format to Roman Numbers or preferred format  

   Under “Start at”, select number one (or “i”).     
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IV. SECOND SECTION: TABLE OF CONTENTS 

A. Step 1 
When you entered the Section Break for the next page, WORD automatically took 
you to a new page.  Use this page as your Table of Contents Page. 

Make sure the page numbering is correct:  

Select View 

 Select Header and Footer 

  Remove the “SAME AS PREVIOUS” (Click on the Icon that looks  
like a pair of Sunglasses)  
 

 

Insert the Page Number by selecting the fist Icon in the 
Header & Footer Toolbar, which is the number symbol: #  

 

You should have roman numeral “i” in your footer.  If 
not, follow the steps from the Cover Page section to 
change the format.   
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This is how the WORD Help Icon says to create page numbers for the Table of Contents:  

You can leave the header or footer off the first page or create a unique first page header or footer 
for the first page in a document or the first page of each section within a document. 

1. If your document is divided into sections, click in a section or select multiple sections 
you want to change. Click anywhere in the document if your document is not divided into 
sections.  

2. On the View menu, click Header and Footer.  

3. On the Header and Footer toolbar, click Page Setup .  
4. Click the Layout tab.  
5. Select the Different first page check box, and then click OK.  

6. If necessary, click Show Previous or Show Next on the Header and Footer 
toolbar to move into the First Page Header area or First Page Footer area.  

7. Create the header or footer for the first page of the document or section.  

If you don’t want a header or footer on the first page, leave the header & footer areas blank.  
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B. Step 2: TOC Using Automatic Headers 
 
 
You can use Microsoft Word to create a Table of Contents that will automatically 
update the page numbers on which your section headers appear.  There are two 
ways to do this: (1) using automatic headers or (2) using the document map.  This 
section covers automatic headers; the document map is next. 
 

1. The Simple Way 
 
The model brief template on the moot court website has legal-style headings 
already programmed.  To use these, simply save the model brief template to you 
computer and start typing.  To create a new header, hit CNTRL+ALT+1, then 
hit TAB to move the header to the level that you want.  Hit ENTER when 
you’re done and it will move to your body paragraph 
 
 

2. Making Your Own Headers 
 
Headers can be customized in Word. 
 
 Select Format 
 
  Then select Style 
 

Click on the type of Style you want to adjust. “Heading 1” is 
the top-level heading (Roman numerals: I / II / III / IV).  
“Heading 2” is the second level heading (A, B, C, D); and so 
forth. 
 
Unclick any box that says “Automatically Update” 
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C. Alternate Step 2: TOC Using the Document Map 
 
Type:  

Table of Contents 
[centered text – “ctrl e”] 

Page 
[Right flush- “ctrl r”] 

1. VIEWING THE TABLE OF CONTENTS WITH A 
DOCUMENT MAP  

 
 The easiest way to create a table of contents is to view the outline with the Document 
Map feature.  This is the icon on the right side that looks like a magnifying glass on top of an 
Excel Spreadsheet.   
 
The image below is this document with the Document Map Outline displayed. 
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The image below is a completed brief with the Document Map Outline displayed.  
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2. INSERTING THE TABLE OF CONTENTS  
 
You have already created a page for the Table of Contents.  Go into that page and insert!   

The easiest way to create a table of contents is to use the built-in outline-level formats or heading 
styles. If you are already using outline-level formats or built-in heading styles, follow these 
steps: 

1. Click where you want to insert the table of contents.  
2. On the Insert menu, point to Reference, and click Index and Tables.  

 

3. Click the Table of Contents tab.  
4. To use one of the available designs, click a design in the Formats box.  
5. Select any other table of contents options you want.  

If you aren't currently using outline levels or built-in styles, do one of the following: 

Create a table of contents from outline levels  

1. On the View menu, point to Toolbars, and click Outlining.  
2. Select the first heading that you want to appear in the table of contents.  
3. On the Outlining toolbar, select the outline level that you want to associate with the 

selected paragraph.  
4. Repeat steps 2 and 3 for each heading that you want to include in the table of contents.  
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5. Click where you want to insert the table of contents.  
6. On the Insert menu, point to Reference, and click Index and Tables.  
7. Click the Table of Contents tab.  
8. To use one of the available designs, click a design in the Formats box.  
9. Select any other table of contents options you want.  

Create a table of contents from custom styles 

If you've already applied custom styles to your headings, you can tell Microsoft Word which 
styles to use when it's building the table of contents.  

1. Click where you want to insert the table of contents.  
2. On the Insert menu, point to References, and click Index and Tables.  
3. Click the Table of Contents tab.  
4. Click Options.  
5. Under Available styles, find a style you've applied to headings in your document.  
6. Under TOC level, to the right of the style name, enter a number from 1 to 9 to indicate 

the level you want that heading style to represent.  

Note  If you want to use only custom styles, remove the TOC level numbers for the built-
in styles, such as Heading 1.  

7. Repeat steps 5 and 6 for each heading style you want to include in the table of contents.  
8. Click OK.  
9. To use one of the available designs, click a design in the Formats box.  

Select any other table of contents options you want. 
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V. SECOND SECTION (continued): TABLE OF AUTHORITIES  

Insert a Hard Page Break [CNTRL + ENTER] and create the Table of Authorities, 
just like you did the Table of Contents.  Your page numbering automatically 
continues.   

There are two ways to create and update a Table of Authorities – (1) manually and 
(2) automatically in MS Word.   

• Manually has the benefit of being easier for people not 
very comfortable using MS Word’s functions.  Essentially, 
you finalize your brief then go page-by-page and manually 
enter in your TOA the page numbers of where your 
authorities appear.  The drawback to this is that if you add 
or delete parts of your brief, your TOA pagination will likely 
be wrong. 

• Automatically has the benefit of letting you edit your brief 
as much as you want and the TOA will automatically create 
itself and update itself.  The drawback is it requires more 
work when you type in a citation and a deeper understanding 
of MS Word. 
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A. TOA the Manual Way 
 
The manual way is preferred by MS Word novices; but even experienced MS Word users may 
find the manual way the easier road to take.  
 

1. Finish drafting your brief.  

2. Go through your brief citation-by-citation.  Copy the citation and paste it into the 
appropriate section of your TOA. Each authority should be listed only once in the TOA. 

3. Remove any pincites that appear in your TOA!   
4. Sort your authorities alphabetically within each section.  For cases, Supreme Court 
cases should come first, then Court of Appeals, then District Court, then State courts. 

5. Print out a copy of your brief. 

6. Find a big table.  Place your TOA on one side and have your brief on the other side. 
Go page-by-page of your brief and when you find a citiation, write that page number 
down on your TOA.  To go faster, you can have your teammate call out authorities and 
you write them down.   

a. Essentially, you should do this page-by-page spot check even using the 
“automatic” way as explained in the next section, just to be sure you 
flagged all of the citations. 

7. Enter all the page numbers you wrote down into your MS Word document. 

8. Spot check to ensure the page numbers correspond. 
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B. TOA the Automatic Way 
 
If you’re feeling confident, you can use Microsoft Word to automatically track the 
page numbers on which your authorities appear. This way, if you make last minute 
changes, if will not throw your TOA off. 
 

1. MARKING ITEMS FOR TABLE OF AUTHORITIES  
 

A Table of Authorities is a list of the references in a legal document, such as references to 

cases, statutes, and rules, along with the numbers of the pages the references appear on.) 

 

Familiarize yourself with the categories:  Press the Alt, the Shift and the letter “I” keys.  

  

Select the Category Icon:  
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2. Viewing the Field Codes  

Field codes: TA (Table of Authorities Entry) field 

{ TA [Switches ] } 

Defines the text and page number for a table of authorities entry. 

Note   The TA field is formatted as hidden text and displays no result in the document. Hidden 
text is character formatting that allows you to show or hide specified text. Microsoft Word 
indicates hidden text by underlining it with a dotted line.  

To view this field, click Show/Hide ¶  on the Standard toolbar. 

\b   
Applies bold formatting to the page number for the entry. The field { TA "Loren v. 
Mendel" \b } displays the entry as "Loren v. Mendel.........23" in the table of authorities. If 
the Table Of Authorities style for the entry already has bold formatting, the \b switch 
removes it.  

 
\c "Category"  

Specifies the entry category, which is a number that corresponds to the order of 
categories in the Category box in the Mark Citation dialog box. The number determines 
how citations are grouped in tables of authorities. The field { TA \l "Hotels v. Leisure 
Time" \c 2 } is included only in the table of authorities inserted by the field { TOA \c 2 }, 
where "2" corresponds to "Statutes". If you omit the \c switch, category 1 ("Cases") is the 
default.  

 
\i  

Makes the entry's page number italic. The field { TA "Loren v. Mendel" \i } displays the 
entry as "Loren v. Mendel.........23 " in the table of authorities. The switch removes the 
italic formatting if the Table Of Authorities style for the entry is italic.  

 
\l "Long"  

Defines the long citation for the entry in the table of authorities. This citation is from the 
Long Citation box in the Mark Citation dialog box (Insert menu, Reference submenu, 
Index and Tables command).  

 
\r Bookmark  

Inserts as the entry's page number the range of pages marked by the specified bookmark. 
The field { TA \l "Hotels Corporation v. Herder Assoc. 483 F.2d 247 (3d Cir. 1990)" \r 
hotelsvherder } displays the entry's page number in the format "20–25" in the table of 
authorities.  
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\s "Short"  

Defines the abbreviated form of the entry; this citation is from the Short Citation box in 
the Mark Citation dialog box (Insert menu, Reference submenu, Index and Tables 
command).  
 

EXAMPLE:  

The field { TA \l "Baldwin v. Alberti, 58 Wn. 2d 243 (1961)" \s "Baldwin v. Alberti" \c 1 \b } 
creates the following entry in the "Cases" category of a table of authorities: 

Baldwin v. Alberti, 
     58 Wn. 2d 243 (1961)               5,6 

 

This is how the WORD Help Icon instructs you to Create a Table of Authorities 

The feature described in this Help topic is only available if support for English (U.S.), Canadian, 
French or Dutch is enabled through Microsoft Office Language Settings. 

1. Mark citations to add to a table of authorities.  
1. Select the first long citation in your document.  

 For example, select "Forrester v. Craddock, 51 Wn. 2d 315 (1957)."  

2. Press ALT+SHIFT+I.  
3. In the Selected text box, edit the long citation as you want it to appear in the table 

of authorities.  
4. If you want to format the text, right-click the text you want to format in the 

Selected text box, and click Font. Select the formatting options that you want to 
use.  

5. In the Category box, click the category that applies to the citation.  
6. In the Short citation box, edit the text so that it matches the short citation that you 

want Microsoft Word to search for in the document.  For example, enter 
"Forrester v. Craddock."  

7. To mark a single citation, click Mark. To mark all long and short citations that 
match those displayed in the Mark Citation dialog box, click Mark All.  

8. To find the next citation in the document, click Next Citation.  

 Click where you want to insert the table of authorities.  

2. To make sure that the document is paginated correctly, you need to hide field codes and 
hidden text. If the TA (Table of Authorities Entry) fields are visible, click Show/Hide on 
the Standard toolbar.  
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SAMPLE OF TEXT FROM A BRIEF  
 

  This bright line rule—if Congress cannot enact a measure directly using its 

other constitutional powers, then Congress may not enact the measure indirectly 

using the Spending Clause—does not mean that the Spending Clause is eviscerated 

or that Congress may not impose non-discrimination requirements on recipients of 

federal funds. For example, Congress, in the exercise of its powers under the 

Fourteenth Amendment Enforcement Clause, U.S. Const. amend. XIV, § 5, may 

compel the States to comply with the Constitution. See City of Boerne v. Flores, 521 

U.S. 507, 536 (1997). Thus, Congress, in the exercise of its powers under the 

Spending Clause, may enact Title VI, 42 U.S.C. § 2000d , and Title IX, 20 U.S.C. 

§ 1681, both of which are co-extensive with the Equal Protection Clause, U.S. 

Const. amend. XIV, § 1. See Grutter v. Bollinger, 539 U.S. 306, 342 (2003); Gratz 

v. Bollinger, 539 U.S. 244, 276 n.23 (2003) (Title VI is coextensive with the Equal 

Protection Clause.).1  

 

 

                                                 
1 Although Grutter and Gratz were addressing only Title VI, the reasoning is 
equally applicable to Title IX. Title VI and Title IX “operate in the same manner, 
conditioning an offer of federal funding on a promise by the recipient not to 
discriminate, in what amounts essentially to a contract between the Government 
and the recipient of funds.” Gebser v. Lago Vista Indep. Sch. Dist., 524 U.S. 274, 
286 (1998). 
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3. Marking Entries for a Table of Authorities  
 
The first item selected is the section symbol §.   

 

Select the text you want to mark. 
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Fourteenth Amendment Enforcement Clause, U.S. Const. amend. XIV, § 5, 

 

 Edit the Select Text.  (This is what will appear in the Table of Authorities.)   
Make sure the Short Citation is correctly identified.  This amendment is referred 
to as the Fourteenth Amendment Enforcement Clause instead of U.S. Const. 
amend. XIV.  You have to tell WORD what to look for.    

  

Select the Category Type.  If your category does not exist, you can create 
one.   
 

Select “MARK ALL.”   
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City of Boerne v. Flores, 521 U.S. 507, 536 (1997) 

    

Title VI, 42 U.S.C. § 2000d 
 
In this selection, the Solicitor General asked that I indicate that this is referred to al 
Title VI in the Table of Authorities.  Notice that I rearranged the text in the 
Selected Text area.   
 

 
 
Continue marking cases and the various authorities.   
 
Be mindful of the categories!   
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What is wrong with the following citations? 
 
 

 
 
 
 

 
 



24 

 
 
 
 
A sample of a unique marking.  
 
§ 504 of the Rehabilitation Act of 1973, 29 U.S.C. § 794 
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4. INSERTING THE TABLE OF AUTHORITIES  
 
You have already created a page for the Table of Authorities.  Go into that page and insert!   

1. On the Insert menu, point to Reference, click Index and Tables, and then click the 
Table of Authorities tab.  

2. In the Category box, click the category you want to include in your table of authorities.  
3. To include all categories, click All.  

 

4. Do one of the following:  
o To use one of the available designs, click a design in the Formats box.  
o To design a custom table of authorities layout, choose the options you want.  

Tip 

To use additional options for customizing a table of authorities, you can use fields. For 
example, you can build the table of authorities for only part of the document. 

5. Select any other table of authorities options you want.  

For Help on an option, click the question mark, and then click the option. 
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Notes 

• If you add, delete, move, or edit a citation or other text in a document, you should 
manually update the table of authorities. For example, if you edit a citation and move it to 
a different page, you need to make sure that the table of authorities reflects the revised 
citation and page number. To update the table of authorities, click to the left of it and 
press F9.  

 

• Don’t modify the entries in the finished table of authorities; otherwise, the next time you 
rebuild the table of authorities, your changes will be lost.  
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VI. THIRD SECTION: THE ARGUMENT  

Near the bottom of that page after your table of authorities, insert a Section Break, 
and repeat the steps for a Section Break.  You will be on a new page and you will 
want to change the numbers to be 1,2,3, etc..  Repeat the steps for changing the 
style of the number format in the Header and Footer.  (Yes, you can do this.!)   

Now research and write your brief. 

ALWAYS UPDATE YOUR FIELDS BEFORE TAKING THE 
BRIEF TO FINAL PRINT! 

You can do this very quickly, and ta-da, it’ll be all updated!  First, simply move the 
mouse over the Table of Contents area and right click. 

 Select “Update Field” 

 
  Click on the button for “Update entire table” and click OK. 

 
Repeat the same for the Table of Authorities if you did that the automatic way. 


